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1 Pre-Requisites 

EMS Remote Management Tool must be installed on a Microsoft Windows PC or Server with 

a minimum Operating System requirement of: 

• Either: 

Windows 7, either x86 or x64. 

Or: 

Windows Server 2008, either x86 or x64. 

• The Host machine must have a DVD reader and at least one free USB Port. 

• There must be HTTP (Port 80) access from the Host machine to the EMS Server. 
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2 Installation  

The EMS Remote Management Tools are intended to be installed on machines remote from 

the EMS Server. As many instances as required may be installed without further licensing 

implications. 

The EMS Remote Management Tools are installed from the main EMS Installer dialog as 

follows: 

1. Run Install.exe from the installation media. 

2. Select Install EMS Remote Management Tools. 

3. Deselect Install EMS Server Components. 

4. Select Next. 

5. Follow the on-screen instructions.  
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3 Overview 

The EMS Remote Management Tools are intended primarily for System Supervisors and 

Expert Users. 

They provide an HTTP link to data in the EMS Database, allowing hardware devices at remote 

locations to be configured and associated with an existing EMS System. 

Once a device has been added to EMS via the Web Interface, the Remote Management Tools 

can be used to perform Configuration tasks on that device such as Synchronising, Calibrating 

and Merging.  

The tools currently provide the capability to perform the following tasks: 

• Synchronising USB Devices. 

• Calibrating USB Devices. 

• Merging USB Devices. 

• CR3 Network Configuration. 

• SR2 Network Configuration. 

• SR2 Device Configuration. 

• Current Clamp Configuration. 

• Wood Watch Configuration. 

• AE Device Configuration. 
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4 Using the Remote Management Tools 

4.1 Starting 

1. Open the EMS Remote Management Tools by -  

Either: 

Clicking on the Desktop Icon. See Figure 1 below: 

 

Figure 1 

Or: 

Selecting the EMS Remote Management Tools entry in the Start menu. 

• The EMS Connection window is displayed. See Figure 2 below: 

 

Figure 2 

Note:  ‘EMS’ at the end of the URL shown in Figure 2 above must be entered in 

uppercase. 

2. Enter: 

• A EMS Username and Password. 

• The URL of the EMS System that you wish to communicate with. 

If the user has been added to EMS as an Active Directory account, the username should 

be in the form: <domain>\<username> 

The User will need to be either setup as a Calibration Technician, or have Edit View 

access, to be able to carry out USB based operations on Hanwell Pro sensors. 

The URL should be in the form: http://<hostname>/EMS/ 



 

Hanwell EMS Remote Management Tools 

User Guide 
 

 

IM6000 - 7 Page 6 of 24 hanwell.com 

 

Replace <hostname> with the hostname or IP address used to reach your EMS Server. 

See Figure 2 above. 

3. When you are sure that the fields have the correct information, click on OK to continue. 

4.2 Selecting Sensors 

The EMS Remote Management Tool window is displayed once the Remote Management 

Tools have loaded. See Figure 3 below: 

• Sensors can be browsed by navigating Sites and Groups. 

To switch the view mode between Sites and Groups 

Either: 

Select the corresponding View menu option. 

Or: 

Click the appropriate Tool Bar button.  

• Sites and groups can be navigated by -  

Either: 

Using the tree view to the right of the screen. 

Or: 

Using the Next Grid and Last Grid options in the View menu 

Or: 

Using the Back and Forward tool buttons in the top left of the screen as shown in Figure 

3 above. 

Back and 

Forward 

Buttons 

Figure 3 
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• Sensors are selected by simply clicking on them. 
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5 Performing Tasks 

5.1 Synchronising a Sensor Unit 

The Synchronise process takes data from a connected USB device and updates its Serial 

Number and Calibration details in EMS, at the same time as setting the Physical Transmit ID 

of the device. 

• Synchronising Sensors facilitates efficient communication between the Sensor and EMS. 

• Even if the sensor is already running on EMS, it is strongly recommended to carry out 

Synchronisation to set a faster transmit rate for the Calibration run. 

To Synchronise a Sensor: 

1. Ensure that the Sensor is plugged into the PC/Network using the supplied USB cable. 

2. Select the correct Sensor from the EMS Remote Management Tools EMS Management 

window. See Figure 3 above. 

3. Making sure that Management Tool has been selected in the right-hand Selection 

menu, right click on the selected Sensor and select Sync Selected Sensor from the 

displayed menu. See Figure 4 below: 

 

Figure 4 

• The EMS Synchronise USB Sensor Vx.x window is displayed. See Figure 5. 
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Figure 5 

Note: The sensor selected must match the physical device or the program will not 

complete. 

4. Make a note of the value in the Transmit interval field, so that the Unit can be reset 

after calibration. 

5. Select the required TX interval from the Transmit interval drop-down list (60 seconds is 

recommended for Calibration). 

• The EMS Synchronise USB Sensor Vx.x window completes loading and all the 

fields are populated. 

6. Click the Synchronise button and follow the instructions given until it reports that the 

Synchronisation is complete.  

7. Close the window to finish and update the EMS database. 

8. Repeat this procedure for all Sensors. 
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5.2 Calibrating Sensors 

The Calibration process takes Sensor Calibration (CAL) Settings from the EMS database and 

loads them into a selected, USB connected, sensor. 

To Calibrate a Sensor: 

1. Ensure that the Sensor is plugged into the PC/Network using the supplied USB cable. 

2. Select the correct Sensor from the EMS Remote Management Tools EMS Management 

window. See Figure 3 above. 

3. Right-click on the selected Sensor’s entry and select Calibrate Selected Sensor from 

the displayed drop-down menu. 

• The EMS USB Sensor Calibration VX.X window is displayed. See Figure 6 below: 

 

Figure 6 

Note: The Sensor’s Serial/ID Number and Type must match, or the program will not 

complete. 

4. Click on the Send Calibration button and follow the instructions given until it reports 

that the calibration is complete. 

5. The Sensor's display should show the same value as displayed in EMS. 

6. Repeat Steps 1 - 5 for all Units. 

5.3 Merging Sensors 

The Merge process allows the Sensor’s internally logged data to be downloaded from a 

connected sensor and added to EMS. 

To Merge a Sensor: 

1. Ensure that the Sensor is plugged into the PC/Network using the supplied USB cable. 

2. Select the correct Sensor from the EMS Remote Management Tools window. See Error! 

Reference source not found. above. 

3. Right-click on the selected Sensor’s entry and select Merge Selected Sensor from the 

displayed drop-down menu. 
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• A Merge window similar to that shown in Figure 7 below is displayed: 

 

Figure 7 

4. When the Merge window has completed loading, click on the Download button. 

• Once the download is complete, Download Complete will be displayed in the 

bottom left-hand corner of the window and the Save Data button will be enabled. 

5. Click on Save Data. 

6. Once the download is complete, close the window to finish and update the EMS 

database. 

5.4 CR3NW and SR2 Network Configuration 

Hanwell Control Receivers (CR3NW) and Smart Receivers (SR2) must be configured before 

use.  This is normally done on the Network but, in some instances, it may be necessary to 

connect the CR3NW/SR2(s) directly to a laptop or desktop. 

Before the CR3NW/SR2(s) can be configured, fixed IP Addresses should be assigned to each 

Unit by the Network Manager. 

You should also know the Subnet and Gateway addresses. 

The CR3NW/SR2 should be connected to the Network using a straight-through Network Lead 

(supplied). 

1. Use the following Steps to assign an IP addresses or addresses to the CR3NW/SR2(s): 

Either: 

i. Access the SR2 Network Configuration Tool directly at: 

www.supportftp.Hanwell.com/Utilities/SRNetworkConfig.zip 

Note: The file SRNetworkConfig.zip contains the generic Network 

Configuration Utility applicable to both CR3 AND SR2 Network 

Receivers. 

http://www.supportftp.hanwell.com/Utilities/SRNetworkConfig.zip
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ii. Download, Unzip and Run the file. 

Or: 

i. Run the EMS Remote Management Tool. 

ii. Select Tools from the EMS Management window’s main toolbar. 

iii. Click on SR2 Network Configuration in the displayed drop-down menu. See 

Figure 8 below: 

 

Figure 8 

• The SR2 NW Network - Configuration utility's home page is displayed, with the 

Network tab selected. See Figure 9. 
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Figure 9 

Note:  The file SRNetworkConfig.zip contains the generic Network Configuration 

Utility applicable to both CR3 AND SR2 Network Receivers. 

2. Click on Search on the lower toolbar (See Figure 9) to start searching the Network for 

connected CR3NW/SR2(s). 

• The program will search for any CR3NW/SR2(s) on the Network. 

• All CR3NW/SR2(s) found will be displayed in the Board list field. See Figure 10 

below. 

• If no CR3NW/SR2(s) are found, you will need to ask your IT Department to check 

the Network. 

• The CR3NW/SR2(s) can be connected directly to a laptop using a crossover cable 

to confirm their operation. 
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Figure 10 

3. Click once on a Unit in the Board List to select it. See Figure 10 above. 

4. Enter the Network Configuration details as specified by your Network Manager and or 

as found in the EMS Pre-requisites document (Document Number: GD5209). 

These details consist of the following: 

• Local IP 

• Subnet 

• Gateway 

• Server IP (should be set to match the Local IP address) 

• Port 

The Port details can be found in the EMS Pre-Requisites document (Document 

Number: GD5977); Hanwell Solutions recommend using the Default Port 10992 for all 

CR3NW/SR2s. 
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5. Enter additional Configuration details as follows: 

i. Set the Operation Mode to Server. See Figure 11 below. 

ii. Confirm that the following options ARE NOT TICKED/CHECKED in the Network 

Configuration Utility's window: 

• Enable Serial Debug Mode 

• Enable DHCP Mode 

• Use UDP Mode 

WARNING: SELECTING ANY OF THESE OPTIONS AND THEN CLICKING ON 

THE SETTINGS ICON WILL DISABLE THE CONTROL DEVICE AND 

REQUIRE ITS RETURN TO THE MANUFACTURER FOR 

RESETTING. 

See Figure 11 below: 

 

Figure 11 

6. Click on the Serial tab. 
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7. Select the following values from the highlighted fields' drop-down lists on the Serial tab: 

Smart Receiver Setting 

Speed 115200 

Parity None 

Data Bit 8 

Stop Bit 1 

Flow Ctrl CTS / RTS 

• See Figure 12 below: 

 

Figure 12 

8. Enter the following values into the highlighted fields on the Option tab. See Table 1. 

Smart Receiver Setting 

Inactivity Time 10 

Time 5 

Size 255 

Char 00 

Table 1 

• See Figure 13 below: 
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Figure 13 

9. Once all the changes have been made, click on the Setting icon to save the 

configuration settings. See Figure 13 above. 

• The following Status windows are displayed. See Figure 14 and Figure 15. 

 

Figure 14 

 

Figure 15 

10. Click on Close on the Complete setting window. 

• Repeat Steps 3 to 10 for any additional SR2s on the Network. 
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5.5 SR2 Device Configuration using the Remote Management Tools 

To configure an SR2 follow the instructions below. 

• For additional information, refer to the Section Configuring the Smart Receiver on a 

Network in the Online EMS User Manual: 

http://www.help.emsprocloud.com/index.html?configuring-the-smart-receiver.html 

1. Ensure that a Sensor using the required SR2 is plugged into the PC/Network using the 

supplied USB cable. 

2. Select the correct Sensor from the EMS Remote Management Tools window. See 

Figure 3 above. 

3. Right-click on the selected Sensor’s entry and select Setup SR2 from the displayed 

drop-down menu. 

• A window similar to that shown in Figure 16 below is displayed, from where the 

System Administrator can initialise and debug SR2 operation. 

 

Figure 16 
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5.5.1 SR2 Clock & Erasing Memory 

The Smart Receiver has an on-board clock used for time/date stamping data. 

• In EMS most date time values, including data values are stored as Greenwich Mean 

Time, (GMT). Setting the clock using the Remote Management Tools will automatically 

set the SR2 clock to GMT. 

• Ideally, you should set the clock so that the time is in synch with EMS Server time: if it is 

out of synch you may get false Elapsed Time alarms. 

• Use the IP Address drop-down, (see Figure 16 above), to select the required SR2 by IP 

address; then click Set Clock to set the SR2 clock. 

• The SR2 time can be checked by clicking Get Clock, to display the SR2’s current date 

time in the status bar; note the SR2 time will be displayed as Greenwich Mean Time, 

(GMT). 

• On Initial installation, an SR2 should have its memory erased. Click Erase to erase the 

selected SR2’s memory. 

• Repeat the Steps in this section, as required, for all SR2s in the IP Address drop-down. 

Note: The available SR2’s IP addresses will only be displayed if using the EMS Remote 

Management Tool. If using the SR2 Network Configuration Tool, you will need to 

manually enter each SR2 Unit’s IP address in the correct format. 

5.6 Current Clamp Configuration Using the Remote Management Tools 

To configure a Current Clamp Device, ensure that the device is plugged in using a USB cable 

then select Current Clamp Configuration from the Tools menu and you should see a window 

similar to the one shown in Figure 17 below.  
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Figure 17 

See Document: IM6015 4000 Series Current Clamp Devices Instruction Manual for further 

details. 

5.7 Importing RadioLog 8 and Hanlog32 Sensor Data 

RadioLog 8 and Hanlog32 files can be imported into an existing EMS System using the EMS 

Remote Management Tools. 

Note: This feature is turned off by the application of a W901 Compliant Licence. 

5.7.1 Restrictions 

• Files can only be imported to the Hanwell Pro Radio or Hanwell Pro Logger families of 

sensors on the EMS System. 

• The Sensor that data is being imported from must be added to EMS before the data 

import. 

• Both the Physical Sensor that the data originated from and the EMS Sensor that the Data 

is to be imported into, must be the same type, with the same number of channels; for 

example, you cannot import data from a PT100 sensor to a Thermistor sensor. 

5.7.2 Importing Data 

1. From the EMS Management window, displayed when the Remote Management Tools 

have loaded, select the required Site and Grid from the right-hand Selection tree. See 

Figure 18 below: 
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Figure 18 

2. In the table of Grid sensors on the left-hand side of the EMS Management window, click 

on the Sensor you wish to import data into. 

3. Either:  

i. Left click on required Sensor's entry to highlight its entry. 

ii. Right click on the highlighted entry to display a drop-down menu. 

iii. Click on Import Sensor Data from the displayed drop-down menu. See Figure 19. 

 

Figure 19 

Or: 

i. Click on the Sensor's entry to highlight it. 

ii. Select Import Sensor Data from the Tools menu. See Figure 20 below: 



 

Hanwell EMS Remote Management Tools 

User Guide 
 

 

IM6000 - 7 Page 22 of 24 hanwell.com 

 

 

Figure 20 

• An Open file dialog will display, allowing you to select the required RadioLog 8 or 

Hanlog32 file for import. 

4. Select the required RadioLog8 or Hanlog file to import data from. 

5. Click on Open. 

• The System will perform file checking before importing data. 

Warning messages in the following formats may be displayed during this process: 

• If the file and EMS sensor types do not match, an error message will be 

displayed and the import will be abandoned. 

• If the Serial Number does not match, the User will receive a warning but may 

continue. 

• For Radio transmitters; if the Radio Transmitter ID and EMS PID do not 

match, the User will receive a warning but may continue. 

• When the data import starts, a Progress window is displayed showing the 

progress of the import via a progress bar, along with an estimate of the remaining 

import time. 

Once imported, the Progress window dialog will close. 

• As an example, a RadioLog file with half a million records will take about 3 

minutes to import. 

Note: The time taken to import the data is dependent on number of records, 

the Network, the PC the Remote Management Tool is installed on and the 

EMS Server's performance. 
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6 Contact Hanwell Solutions 

UK Customers: 

Ellab Monitoring Solutions Limited 

Pendle House 

Jubilee Road 

Letchworth 

Hertfordshire 

SG6 1SP 

 

Tel: 01462 688070 

Email: sales.hanwell@ellab.com 

Web: www.hanwell.com 

 

For Technical Support: 

Tel: 01462 688 078 

Email: support.hanwell@ellab.com 

 

EU & Overseas Customers: 

Please contact your local Hanwell Distributor. 

A list of distributors is available at: www.hanwell.com/distributors/ 

 

mailto:sales.hanwell@ellab.com
http://www.hanwell.com/
mailto:support.hanwell@ellab.com
http://www.hanwell.com/distributor
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Document History 
Document Number: IM6000 

Issue 

No. 
Issue Date Changes By 

1 11 July 2018 First Issue. IR 

2 15 October 2018 Formatting Changes and Corrections. IR 

3 30 January 2019 
Addition of information on Importing 

RadioLog 8 and Hanlog32 Sensor Data. 
IR 

4 4 February 2020 Rebranding of manual to include Ellab. IR 

5 18 February 2020 

• Addition of Warning relating to 

Network Configuration Utility. 

• Addition of references to CR3NW. 

IR 

6 14 January 2021 Add Active Directory integration CRB 

7 29 September 2021 

• Amendments to Contact Details to 

reflect change to Ellab Monitoring 

Solutions 

• Document History moved to end of 

document 

IR 
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